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Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as an RSS feed and set content to be 
delivered directly to your desktop using a reader application. The RSS feeds are a free service. Cisco currently 
supports RSS Version 2.0.
v
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C H A P T E R 1

Overview

The Cisco Smart+Connected Residential Solution is a highly flexible and expandable platform for 
residential automation. This guide provides an overview of the process to design, install, and configure 
the devices and features in a typical residential dwelling. 

Refer to the following topics for more information.

Contents

 • Requirements, page 1-1

 • Summary Steps, page 1-2

 • Obtaining and Installing Licenses, page 1-4

 • Related Documentation, page 1-4

Requirements
Table 1-1 Requirements 

Requirements Related Documentation

Requirement 
Complete? 

( )

Gain a solid understanding of the Cisco Smart+Connected 
Residential Solution, including supported devices, software tools, 
and remote management

 • Complete the Cisco 
Smart+Connected Residential 
training.

 • Solution overview, white paper, case 
studies, and other information: 
www.cisco.com/go/smartconnected
residential

 • Study the documents in the “Related 
Documentation” section on 
page 1-4.

Review all sections of the current guide before you begin. Cisco Smart+Connected Residential 
Installation and Configuration Guide
1-1
ed Residential Installation and Configuration Guide
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  Summary Steps
Summary Steps
This guide provides a summary of the main tasks required to install and configure a Cisco 
Smart+Connected Residential Solution in one or more dwellings. The exact details for your deployment, 
and the residences within that deployment, will vary. Consult your Cisco representative to carefully plan 
and implement the supported features and devices.

The following is a high-level summary of the main tasks.

A Windows PC to run design and installtion software such as 
Microsoft Visio and Composer Pro.

 • Design and Estimate Requirements, 
page 2-4

 • Install the Composer Pro Software, 
page 5-7

 • Composer Pro User Guide

Internet access and a wireless router and network switch for each 
residence.

Network Requirements, page 3-3

The Cisco and third-party devices required to support your solution 
design. 

 • Create the Design and Estimate 
Plans, page 2-1

 • Network Requirements, page 3-3

 • Related Documentation, page 1-4

The electrical, network, serial, and other cables required to 
implement the solution in each dwelling.

See your real estate developer for the 
specific requirements for each new or 
retrofit residence.

Review the individual topics in this guide for additional 
requirements. 

For example:

 • Network Requirements, page 3-3

 • Design and Estimate Requirements, 
page 2-4

 • Installation Requirements, page 4-6

 • Template Configuration 
Requirements, page 5-2

Table 1-1 Requirements (continued)

Requirements Related Documentation

Requirement 
Complete? 

( )

Task Related Documentation

Task 
Complete? 

( )

Step 1 Complete the requirements that apply to your deployment and the 
installation task(s) you will perform.

Requirements, page 1-1

Step 2 Create one or more designs for the equipment that will be installed 
in a typical residence.

Create the Design and Estimate 
Plans, page 2-1
1-2
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Step 3 Install the networking equipment in each residence. Network Requirements and 
Best Practices, page 3-1

Step 4 Install the automation devices in the residence. Install and Connect the Physical 
Components, page 4-1

Step 5 Create the Cisco Controller template(s). Create the Basic Cisco 
Controller Project, page 5-1

Step 6 Add additional devices to the project, if necessary. Adding Additional Devices to 
the Template, page 6-1

Step 7 Add and configure the video intercom, if necessary. Configuring the Intercom for 
Communication Within a 
Dwelling, page 7-1

Step 8 (Optional) Install and configure the Cisco Smart+Connected 
Remote Management Solution (Cisco RMS).

Cisco Smart+Connected 
Remote Management Console 
Administration Guide

Cisco Smart+Connected 
Remote Management Server 
Installation Guide

Task Related Documentation

Task 
Complete? 

( )
1-3
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Obtaining and Installing Licenses
Feature licenses must be purchased to enable optional features such as smart device access, or 
deployment using the Cisco Smart+Connected Remote Management Solution. 

For information to purchase, install and activate feature licenses, refer to the Cisco Smart+Connected 
Residential Licensing and Registration Guide. 

Related Documentation
For more information about the Cisco Smart+Connected Residential products, see the following 
documents and websites: 

Subject / Document Title Location

General

Product Information and Home Page www.cisco.com/go/smartconnectedresidential

Data Sheets http://www.cisco.com/en/US/products/ps1244
5/products_feature_guides_list.html

Cisco 1-Year Limited Hardware Warranty Terms www.cisco.com/go/smartconnectedresidential
warranty

Regulatory Compliance and Safety Information for Cisco Smart+Connected 
Residential Products

www.cisco.com/go/smartconnectedresidential/
docs

Cisco Support www.cisco.com/cisco/web/support/

ReleaseNotes

Release Notes for the Cisco Smart+Connected Residential Solution www.cisco.com/go/smartconnectedresidential/
docs

Installation and Configuration

Cisco Smart+Connected Residential Installation and Configuration Guide www.cisco.com/go/smartconnectedresidential/
docs

Cisco RMS Installation and Administration

Cisco Smart+Connected Remote Management Console Administration 
Guide

Cisco Smart+Connected Remote Management Server Installation Guide

www.cisco.com/go/smartconnectedresidential/
docs

Hardware Reference Guides
1-4
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  Related Documentation
Note For information about third-party hardware and software, see the manufacturer’s product documentation 
and/or website.

Cisco Smart+Connected Controller 200 Reference Guide

Cisco Smart+Connected Controller 250 Reference Guide

Cisco Smart+Connected Controller 800 Reference Guide

Cisco Smart+Connected 7” In-wall Display Reference Guide

Cisco Smart+Connected Portable Tablet Reference Guide

Cisco Smart+Connected I/O Extender Reference Guide

Cisco Smart+Connected Universal Remote 150 Reference Guide

Cisco Smart+Connected Universal Remote 250 Reference Guide

Cisco Smart+Connected Video Door Station Reference Guide

www.cisco.com/go/smartconnectedresidential/
docs

Accounts and Licensing

Cisco Smart+Connected Residential Licensing and Registration Guide See your Cisco representative or partner for 
more information.

Other

Smart Device Compatibility and other information:

Cisco Smart+Connected Smart Device License for Real Estate Developers

www.cisco.com/go/smartconnectedresidential

 Composer Pro User Guide http://www.control4.com/documentation/Com
poser_Pro_User_Guide/index.htm
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C H A P T E R 2

Create the Design and Estimate Plans

Use the design and estimate process to define the devices and connections in a Cisco Smart+Connected 
Residential Solution. The resulting drawings and reports also provide wiring and layout requirements, 
and estimate the bill of materials (BOM) for the project.

Refer to the following topics for more information.

Contents

 • Overview, page 2-2

 • Design and Estimate Requirements, page 2-4

 • Summary Steps, page 2-4

 • Download and Install the Cisco Smart Shapes for Visio, page 2-5

 • Create a Concept Drawing and BOM Report, page 2-8

 • Create a Single Line Drawing, page 2-12
2-1
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  Overview
Overview
This Cisco Smart+Connected Residential Design and Estimate tool allows you to quickly define the 
design assets for a residence, and generate reports that include connection and wiring diagrams, cost 
estimates, keypad engraving details, and other information.

To use this tool, download and install the S+C Design and Estimate Tool.zip file. This file includes 
the following:

 • Cisco Smart+Connected Residential Smart Shapes that are imported into Microsoft Visio (2007 or 
later). These shapes provide descriptions, part numbers, pricing and other information about Cisco 
and select 3rd party products.

 • The Design and Estimate Tool Template v1.vst, a Visio template file that contains three 
different drawing tabs. These three drawings (Concept Drawings, System Overview and Single 
Line) encompass most of the information you will need to fully describe the project. There will be 
more complex drawing assets required in later stages of the project, but these three should be more 
than enough to get started.

Design Drawing Types
Three types of design drawing produced with the Cisco Smart+Connected Residential Design and 
Estimate tool (Table 2-1).

Table 2-1 Example Drawings 

Drawing Description Example

Concept Drawings A graphical overview of the equipment 
in each room and general device 
connections. This high-level drawing 
does not include specific port 
connections and may or may not include 
wiring. This drawing is for builders or 
installers who require a general system 
understanding.
2-2
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  Design Drawing Types
System Overview A graphical floor plan including the 
equipment to be installed in each room. 
This drawing does not include system 
connections but could include 
infrastructure wiring information This 
provides a general system understanding 
for a builder or architect.

Single Line A detailed connection drawing that 
shows specific port connections, and the 
connections to systems that are external 
to the residence. The audience is the 
builder, architect, or 
pre-wire/installation partner company.

 

Table 2-1 Example Drawings (continued)

Drawing Description Example
2-3
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Design and Estimate Requirements
The following table lists the basic devices that are installed in a Cisco Smart+Connected Residential 
Solution.

Table 2-2 Design & Estimate Requirements 

Requirements Description

Requirement 
Complete? 

( )

Complete the Cisco Smart+Connected 
Residential Design and Estimate Training.

Provides an understanding of the hardware and software 
components in a Cisco Smart+Connected residence, and the 
configuration tasks required for a successful installation.

The Design & Estimate training module also provides 
greater details and examples.

Note The Design and Estimate Training video on demand 
and tools can be viewed and downloaded from the 
Cisco Smart+Connected Residential Partner Portal. 
Please contact your Cisco representative for access 
to the Partner Portal. 

A basic understanding of the following:

 • Control signals (IR, RS232, Relay, 
Contact, and ZigBee)

 • Electrical and lighting control

 • Audio/Video Control

You must understand the controls used to operate the 
devices in a Cisco Smart+Connected residence.

An understanding of Microsoft Visio and Excel 
software packages

You must be familiar with the software tools used to create 
the designs and reports described in this document.

Microsoft Visio 2007 or later Use Visio to design a typical residence and create reports to 
assist in layout, wiring and cost estimates.

Cisco Smart+Connected Residential Smart 
Shapes 

Import the Smart Shapes into Microsoft Visio 2007 (or later) 
and use them to build diagrams and reports.

Summary Steps

Task

Task 
Complete? 

( )

Step 1 Download and install the Cisco Smart Shapes (custom Visio shape stencils).

Step 2 Use the template file, or add stencils to your own .vsd drawing file. 

Step 3 Update the Visio file paths so reports will appear automatically.
2-4
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Download and Install the Cisco Smart Shapes for Visio 
The S+C Design and Estimate Tool.zip file includes a set of custom Visio shape stencils (the .vss 
files) and report templates (in .vrd format). A Visio template file is also included that contains drawing 
tabs for system overview, concept and single line drawings.

Procedure

Step 1 Create a new directory on your computer named Design and Estimate Template (or similar).

Step 2 Download the S+C Design and Estimate Tool.zip file.

Step 3 Extract the S+C Design and Estimate Tool.zip file into the new directory. 

Step 4 Verify that the file structure is similar to Figure 2-1.

Figure 2-1 Design and Estimate Tools

Step 5 Double-click the latest version of the S+C Design and Estimate Tool Template.vsd file to open a new 
Microsoft Video file that includes the following:

 • Cisco Smart Shapes (custom Visio shape stencils).

Step 4 Create a concept drawing.

Step 5 Create reports, such as a BOM report.

Step 6 Create a system overview drawing.

Step 7 Create a single line drawing.

Task

Task 
Complete? 

( )
2-5
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Chapter 2      Create the Design and Estimate Plans
  Download and Install the Cisco Smart Shapes for Visio
 • Concept Drawing page

 • System Overview page

 • Single Line page

Tip To use an existing Visio file, open the file, select File -> Shapes -> Open Stencils and select the 
.vss files included in the Design and Estimate Template folder you created in Step 1. 

Step 6 Verify that the Shapes Window pane includes the Cisco shapes and similar to Figure 2-2 

Figure 2-2 Cisco Smart Shapes Displayed in Visio

Tip Hover over the icons to display information regarding equipment usage (not available for all 
icons). 

Step 7 Update the Visio file paths so reports will appear automatically.

a. Select Tools -> Options then select the Advanced tab then select the File Paths… button. 

b. In the File Paths dialog box (Figure 2-3), click the “…” buttons on the right side and select the 
following file paths:

 – My Shapes—Select the Stencils folder.

 – Drawings—Select the Reports folder.
2-6
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  Download and Install the Cisco Smart Shapes for Visio
 – Templates—Select the top-level folder that contains the .vsd file.

 – Stencils—Select the Stencils folder.

Tip These are sub- folders in the Design and Estimate Template folder you created in Step 1.

Figure 2-3 Visio File Paths
2-7
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Create a Concept Drawing and BOM Report
Procedure

Step 1 Select the Concept Drawing tab. 

Step 2 (Optional) Rename and resize the rooms to reflect the project you are designing. 

Step 3 Drag the shapes from the smart shapes stencil into the drawing (Figure 2-4).

We recommend starting with the Cisco Controllers.

Figure 2-4 Drag and Drop Icons

Step 4 (Optional) Enter Shape Data about the device or component in the dialog box that appears when you 
release the icon. 

Tip Some icons include fields for simple information such as the room where the device is installed. 
Other icons request detailed information such as color and engraving. This information is 
optional but will be very helpful when creating reports later in the design process.

Step 5 Add additional shapes for all Cisco Controllers, user interfaces, network devices, lighting devices, A/V 
devices and 3rd party devices that your design requires (Figure 2-5). 
2-8
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  Create a Concept Drawing and BOM Report
Tip You can always add your own shapes, but those shapes will not appear in reports later in the 
design. 

Figure 2-5 Completed Concept Design

Tip • Double click the icons to add text labels (names) to the shapes. 

 • To resize an icon, click and drag the corners or sides of an icon.

Step 6 Add accessories and software items outside of the drawing page (Figure 2-6). 

Note Items outside of the drawing page will not appear on a printed page, but will show up in the BOM 
and other reports.
2-9
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  Create a Concept Drawing and BOM Report
Figure 2-6 Completed Concept Design

Step 7 Save the design as a drawing file as a .vsd drawing file (instead of a template file) (Figure 2-7).

Figure 2-7 Save the Design as a Drawing File

a. Select File -> Save As.

b. Select Drawing (*.vsd) from the Save as type drop down box. 
2-10
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  Create a Concept Drawing and BOM Report
c. Enter the file name and select a directory.

d. Click Save.

Step 8 Create a report such as BOM Report, Keypad Engraving, or Lighting Report. 

Tip You can also create custom reports, if needed.

a. Select Data -> Reports and the dialog box below should display the three reports (in the Design and 
Estimate Template folder you created in Step 1.

Tip If you saved the .vrd files to a different folder, click Browse and go to that folder to select a 
report.

b. Highlight a report name (such as the BOM Report) and select Run. 

c. Select the report format (such as Microsoft Excel) and any other options that appear (for example, 
HTML reports prompt you for the location to save the report).

Step 9 Verify the report data (Figure 2-8).

Figure 2-8 BOM Report in Excel Format
2-11
Cisco Smart+Connected Residential Installation and Configuration Guide

OL-26433-02



 

Chapter 2      Create the Design and Estimate Plans
  Create a Single Line Drawing
Step 10 (Optional) Format the report, if necessary. 

For example, you can apply a discount rate or change the text and colors (Figure 2-9).

Figure 2-9 Format and Revise the Report

Note If you re-run the report, the original formatting will return and any changes must be reapplied.

Step 11 Save the report.

Create a Single Line Drawing
The Concept and System Overview drawings provide general information about the equipment in the 
system, while the Single Line drawing provides more detailed information about how the equipment 
connects together. 

There is no reporting information included in the Line Drawing shapes but they contain the accurate 
connections for the Cisco and Control4 equipment.

Procedure

Step 1 Select the Single Line tab (Figure 2-10). 

Step 2 Select the S+C Line Drawings Template shapes.
2-12
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  Create a Single Line Drawing
Step 3 Drag and drop devices onto the drawing.

The connections supported by the device are displayed in the drawing.

Step 4 Use the “Connector Tool” to connect the connection points on each shape to the appropriate ports on 
other shapes.

Step 5 Change the color and line thickness of each line to indicate the type of signal.

Figure 2-10 Single Line Drawing

Step 6 (Optional) Create custom shapes for equipment that isn’t in the stencil to complete the design.
2-13
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Network Requirements and Best Practices

Each Cisco Smart+Connected Residential Solution deployment requires a network plan that includes the 
following main elements:

 • Public Internet access to each residence.

 • A residence network that includes:

 – A router to provide a gateway to the Internet and a wireless access point (WAP).

 – A gigabit switch that (optionally) supports power-over-Ethernet (PoE). 

Refer to the following topics for the recommended requirements and best practices regarding the switch 
and router installed in each residence. 

Note Refer to your building network plan and network administrator for more information. 

Contents

 • Overview, page 3-2

 • Network Requirements, page 3-3

 • ZigBee Wireless Requirements, page 3-4

 • Wireless Access Point Best Practices, page 3-5

 • Network Security Best Practices, page 3-5
3-1
ed Residential Installation and Configuration Guide



 

Chapter 3      Network Requirements and Best Practices
  Overview
Overview
Figure 3-1 shows the recommended network configuration. 

 • A router is installed in the residence to provide Internet access. The router also provides a wireless 
access point (WAP) for the Cisco Smart+Connected Residential Solution Wi-Fi devices.

 • The router WAN port is connected to the service provider’s public Internet port.

 • An gigabit network switch provides network connectivity for the wired residential devices. The 
switch also provides power-over-Ethernet (PoE) to the PoE devices in the residence.

 • An Ethernet cable is attached from a router LAN port to the switch. 

 • All wired network devices are connected to the switch (not the router) to ensure robust handling of 
network traffic within the residence, and between the router and networks (such as the Internet) 
outside the residence. 

Figure 3-1 Basic Network Configuration

Note We recommend using wired Ethernet connections (rather that Wi-Fi connections) whenever possible to 
ensure robust and reliable network connectivity. We also recommend using a gigabit switch (rather than 
a 10/100 switch) for optimal system performance.
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Network Requirements
Prepare a network plan that includes the following:

Table 3-1  Network Requirements 

Network Requirements
Requirement 

Complete? 
( )

A service provider WAN port in each residence that provides public Internet access.

A wireless Cisco router installed in each residence that includes the following features:

 • Ethernet ports—At least one wired 1000 BaseT (Gigabit) port

Note Only one LAN port on the router should be used to connect the router to the network switch. Any 
other LAN ports should remain unused to ensure the router capacity is used exclusively for Wi-Fi and 
Internet gateway features.

 • Wireless—Wireless-N

 • Wireless security—Wired Equivalent Privacy (WEP), Wi-Fi Protected Access (WPA), WPA2

 • (Recommended) We recommend enabling DHCP to dynamically assign IP addresses to the Cisco 
Smart+Connected Residential (and third party) devices. If static IP addressing is preferred, see your 
network administrator for more information.

Note We do not recommend using the resident’s personal router. Use only a recommended Cisco router.

A Cisco switch installed in each residence that includes the following features:

 • Number of ports—A sufficient number of Ethernet ports to provide connectivity for all wired devices.

 • Ethernet port speed— 1000 BaseT (Gigabit).

 • Backplane capable of supporting all ports at full bandwidth. For example, a 24 port switch would require 
a backplane with 48 gigabits of non-blocking backplane or switching fabric.

Note Do not use 10/100 BaseT switches. 1000 BaseT (Gigabit) switching is required for high resolution 
video content. 

 • (Optional) Power over Ethernet

Note If additional Gigabit switches are installed in the residence, they should be directly connected to the 
main switch. Do not daisy chain a remote switch to another remote switch, since this can cause poor 
network performance, delays, and data loss.

For example, the Cisco SF302-08P Managed Switch.

A router configuration plan that includes the following for each router:

 • A wireless Network Name (SSID) and password. For security, we recommend using SSIDs or passwords 
that do not include the physical location of the wireless network. For example, do NOT use an apartment 
number, address, or other physical identification. We recommend changing the default SSID and 
password.

 • A router administration password. You can use the same password for all routers, or a unique password 
for each residence. We recommend changing the default password.
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ZigBee Wireless Requirements
ZigBee wireless devices must be within range of other ZigBee devices to successfully form a mesh 
network. The more ZigBee devices installed in a project, the stronger the ZigBee communication mesh 
is. 

The wireless range varies greatly depending on the device type and model, the location of the device 
relative to other ZigBee devices, and physical obstructions between devices. RF interference and other 
wireless devices can also impact signal strength and range.

Table 3-2 ZigBee Wireless Requirements 

Requirement

Requirement 
Complete? 

( )

Perform range tests to verify ZigBee wireless signal strength before you install and configure ZigBee devices 
such as smart plugs or load control modules. This ensures the ZigBee devices can connect to the Cisco 
Controller before you install the actual device.

For example, the Wi-Spy tool from www.metageek.com. 

Install and configure an all-in-one Firewall Virus and Spyware suite to protect the residence from 
unauthorized access while allowing the Cisco Smart+Connected Residential Solution software to function 
properly. See the “Network Security Best Practices” section on page 3-5.

Use a signal strength analyzer to determine the Wi-Fi and ZigBee signal strength available in different 
locations in the residence. For example, the Wi-Spy tool from www.metageek.com, which analyzes both 
Wi-Fi and ZigBee signals.

See the following for more information:

 • ZigBee Wireless Requirements, page 3-4.

 • Wireless Access Point Best Practices, page 3-5.

Complete the “Create the Design and Estimate Plans” section on page 2-1 to define the solution and network 
devices that will be included in the installation. Verify that the following is in place before installing the 
equipment:

 • Install Ethernet wires (such as Cat5e or Cat6) between the locations in the residence that require 
connectivity. For example, from the ISP modem to the wireless router, from the router to the network 
switch, and from the network switch to each wired network device in the residence (such as the Cisco 
Controller, Cisco Smart+Connected 7" In-wall Display, and Cisco Smart+Connected Video Door 
Station).

Table 3-1  Network Requirements (continued)

Network Requirements
Requirement 

Complete? 
( )
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Wireless Access Point Best Practices
Wireless equipment should be installed as close as possible to each other to ensure sufficient signal 
strength. Follow the guidelines in Table 3-3 to maximize wireless signal strength.

Table 3-3 Wireless Networking Practices 

Best Practice Description

Update the firmware on all routers. See the product documentation for more information.

Use a signal strength analyzer (such as the 
Wi-Spy tool from www.metageek.com) to 
determine the Wi-Fi signal strength in different 
locations in the residence. 

Look for high levels of interference, signal/noise ration and signal 
strength. Change channels based on the tool report.

Install the wireless equipment as close as 
possible.

Wireless signals are much stronger when the components are nearby. 

Install the Wi-Fi access point in a central location. Ideally, the customer’s wireless router will be installed in a central 
location to provide a strong signal throughout the residence.

Avoid physical obstructions. Barriers such as walls, floors, furniture, or other objects can degrade 
wireless signal strength. Place the wireless components in locations with 
as few barriers as possible between them.

Avoid reflective surfaces. Metal and glass surfaces can disrupt wireless signals. Place the wireless 
components away from reflective surfaces or move reflective surfaces 
away from the equipment.

Avoid other residential appliances and electrical 
equipment.

Appliances such as wireless phones, microwaves, electric fans, baby 
monitors and fluorescent lighting can interfere with wireless signals. 
Place the wireless components away from other appliances and move the 
appliances.

Adjust the router antennas, if possible. If the Wi-Fi router has adjustable antennas, rotate them and check for 
improved reception.

Experiment with different locations. Move the router or other wireless devices to different locations to improve 
reception.

Note Do NOT use Wi-Fi range extenders or repeaters. These can cause problems upgrading devices and 
interfere with ZigBee communications.

Network Security Best Practices
To protect a Cisco Smart+Connected residence from unauthorized access that can lead to loss of personal 
data, we recommend using an all-in-one Firewall Virus and Spyware suite that is provided from a single 
company. An all-in-one package provides the best protection while minimizing potential conflicts or 
inter-operability issues between the security utilities. 

The security suite must be configured to allow Cisco and Control4 software to function properly and 
access the primary Cisco Controller and other devices in the Cisco Smart+Connected Residential 
Solution. You must add all solution software to the “approved” list of the security suite. 
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See the security software documentation for more information.
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Install and Connect the Physical Components

Refer to the following topics for a summary of the requirements, processes, and related documentation 
required to physically install the devices, components, accessories and cables in a Cisco 
Smart+Connected Residential Solution. 

Contents

 • Overview, page 4-2

 • Summary Steps, page 4-3

 • Installation Requirements, page 4-6
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Overview
Install the physical components according to the line drawing created using the Cisco Design and 
Estimate Tool. The line drawing includes each of the physical components included in the residence, and 
the cable requirements and port connections for each device. You can also refer to the Concept and 
System drawings for additional information regarding device placement and requirements.

In addition, you must install any back boxes required for wall-mounted components such as the Cisco 
In-wall Display, the Cisco Video Door Station, 3 and 6-button keypads, lighting controls, and lighting 
controls. Additional mounting brackets may be required for the Cisco Controllers (such as the Cisco 
Controller 250).

Table 4-1 summarizes resources and additional information that you should consult before installing the 
Cisco Smart+Connected Residential Solution:

Table 4-1 Installation Resources 

Resource Description More Information

Architecture and building 
plans

The appropriate cables, back boxes and electrical 
connections must be installed and functional. 

Development or construction 
manager.

Your network administrator A building network must be installed and functional for 
communication between the residential devices and the 
public services. 

A building network is also required for the remote 
commissioning and monitoring of the Cisco 
Smart+Connected Residential Solution.

Internet access must be available in the residence to 
provide communication between smart devices and 
Internet-based services. An Internet connection also 
provides residents with access to the Internet for their 
personal devices.

See your network administrator 
for more information, and to 
confirm the location and 
configuration of the network 
ports in each residence.

See also the “Network 
Requirements and Best 
Practices” section on page 3-1.

Line drawing

Concept drawing

System overview

Provides detailed descriptions of the physical components 
included in the residence, including the cable requirements 
and port connections for each device (see the line drawing 
example in Figure 4-1).

Create the Design and Estimate 
Plans, page 2-1

Installation Summary The installation summary provided in the “Summary 
Steps” section on page 4-3.

Contents, page 4-1

Summary Steps, page 4-3

Device reference guides The Reference Guide for each Cisco Smart+Connected 
Residential device provides detailed information regarding 
device installation, ports, connections, specifications, 
mounting, warranty, and other information. 

The reference guides also include specifications and 
installation instructions for wall mounted back boxes and 
mounting brackets available for devices such as the Cisco 
In-wall Display, the Cisco Video Door Station, and Cisco 
Controllers.

Cisco Smart+Connected 
Residential Reference Guides

Product documentation for 
network equipment and other 
third-party products

See the product documentation included with the device or 
available online. 

 • Product website
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Figure 4-1 Sample Cisco Design and Estimate Tool Line Drawing

Summary Steps

Task Additional Information

Task 
Complete 

( )

Task Not 
Required 

(X)

Step 1 Create a line drawing that includes the devices, 
connections, cables and other components in the 
residence.

a. Create the concept drawing.

b. Create the system overview drawing.

c. Create the single line drawing.

Create the Design and Estimate 
Plans, page 2-1

Step 2 Gather the devices, cables and other components 
included in the design plan created in Step 1.

Create the Design and Estimate 
Plans, page 2-1

Step 3 Verify that any pre-existing or required wiring, 
electrical connections and back boxes are installed, 
according to the building plan.

Development or construction 
manager.
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Step 4 Install the Cisco router and switch in the residence.

Note Although this document provides examples, 
the exact router and switch model can vary. 
The same installation concepts apply for most 
devices. See your network administrator for 
more information. 

For example:

Router

a. Unpack the Cisco Router and connect the power 
cord.

b. Connect the Ethernet cable from the existing ISP 
network connection (such as a cable or DSL 
modem) into the router port marked “WAN”

c. Power on the existing IPS cable or DSL modem 
and wait until the network connection is active.

d. Power on the router

Switch

a. Unpack the unit and connect the power cord.

a. Connect a Cat5 Ethernet cable from a router LAN 
port to the switch LINK/ACT port.

 • Refer to the installation 
documentation for each device.

 • Related Documentation, 
page 1-4

Step 5 Install the Cisco Controller(s), connect the cables and 
power on the devices according to the design plans.

Cisco Smart+Connected Residential 
Controller Reference Guides

Step 6 Install the Cisco displays:

 • Cisco In-wall Display

 • Cisco Portable Tablet

Cisco Smart+Connected 7” In-wall 
Display Reference Guide

Cisco Smart+Connected Portable 
Tablet Reference Guide

Step 7 Install the internal and external Cisco Video Door 
Station(s).

Cisco Smart+Connected Video Door 
Station Reference Guide

Step 8 Prepare the Cisco Universal Remote(s).

For example, install the batteries.

Cisco Smart+Connected Universal 
Remote 150 Reference Guide

Cisco Smart+Connected Universal 
Remote 250 Reference Guide

Task Additional Information

Task 
Complete 

( )

Task Not 
Required 

(X)
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Step 9 Install the Cisco I/O Extender. Cisco Smart+Connected I/O 
Extender Reference Guide

Step 10 Install the 3rd party devices. For example:

 • Door Locks

 • IP cameras

 • 3 and 6 button Keypads

 • Light switches

 • Motion detectors

Refer to the installation 
documentation for each device.

Task Additional Information

Task 
Complete 

( )

Task Not 
Required 

(X)
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Installation Requirements
The following table lists the basic devices that are installed in a Cisco Smart+Connected Residential 
Solution.

Table 4-2 Equipment Requirements 

Requirements Accessories Description

Requirement 
Complete? 

( )

WAN ports for public Internet 
access and for the building 
network.

Existing modem, router, or other 
access ports.

Residence wireless router: 

For example, the Cisco Wireless 
Router

 • Cat5 Ethernet cable Provides wired and wireless 
network connectivity.

Network switch to provide 
additional network ports.

For example, the Cisco SF302-08P 
Managed Switch

 • Cat5 Ethernet cable Provides additional network 
ports and Power over Ethernet 
(PoE) capability.

Cisco Controller(s)  • Cat5 Ethernet cable

 • RCA A/V cables (if necessary)

 • IR emitter(s)

Manages the residential 
automation features.

Cisco Portable Tablet  • Cat5 Ethernet cable

 • (Optional) Phillips head 
screwdriver and two (2) screws 
(included) to secure the 
touchscreen to the dock

Provides the user interface 
(UI) to navigate and control 
the solution features.

(Optional) Cisco Universal 
Remote

 • 2 AA batteries (included) Controls the Cisco 
Smart+Connected Residential 
equipment and features using 
the TV on-screen Navigator.

Also replaces the customer TV 
remote control for the 
customer TV.

Customer-supplied Television. HDMI, component or composite cables 
(depending on the available television 
input ports).

Displays the on-screen 
Navigator used to control the 
residential automation 
features.

(Optional) Customer TV remote 
control

None Controls the TV if a Cisco 
Universal Remote is not used.
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Create the Basic Cisco Controller Project

A “project” is a Cisco Smart+Connected Residential Solution configuration created using the Composer 
Pro software. This project can be used for a single residence, or backed up to a file and applied as a 
template to multiple Cisco Controllers.

After the basic project configuration is complete and verified, you can add additional devices and 
features, and customize the project using agents and programming.

Refer to the following topics for more information. 

Contents

 • Overview, page 5-2

 • Template Configuration Requirements, page 5-2

 • Summary Steps, page 5-3

 • Overview of the Composer Pro Configuration Tool, page 5-4

 • Install the Composer Pro Software, page 5-7

 • Create the Basic Project Configuration, page 5-8

 • Create the Virtual Connections for Control (Serial) and Audio/Video Devices, page 5-25

 • Verifying and Configuring Lighting Switches and Dimmers, page 5-29

 • Saving the Project as a Template, page 5-31

 • Where To Go Next, page 5-32
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Overview
Templates allow you to quickly configure multiple Cisco Controllers that support identical (or nearly 
identical) sets of Cisco Smart+Connected Residential equipment. For example, you can create a template 
for small residence that include a basic set of devices and services, and another template for residences 
that include additional equipment and advanced services. See the “Create the Design and Estimate 
Plans” section on page 2-1 for information about creating the designs that represent a typical residence 
configuration.

Templates are applied either by manually loading the template file on the Cisco Controllers, or by 
remotely deploying the Cisco Controller using the Cisco Smart+Connected Remote Management 
Solution (Cisco RMS). See the “Related Documentation” section on page 1-4 for links to Cisco RMS 
installation and administration documentation.

Note The project template is first created in a controlled environment (such as a lab or model residence), and 
then applied to the Cisco Controller in each residence.

Template Configuration Requirements
Table 5-1 Template Requirements

Requirements

Requirement 
Complete? 

( )

Your organization must be a Cisco Partner for the Cisco Smart+Connected Residential Solution. See your 
Cisco representative for more information.

A PC running the Microsoft Windows operating system. The PC must be on the same subnet as the Cisco 
Smart+Connected Residential components, including the Cisco Controller.

Composer Pro, version 2.2 or higher. 

 • See the “Install the Composer Pro Software” section on page 5-7.

 • You will be prompted to install the Microsoft .Net Framework during the installation process, if 
necessary. 

A complete set of physical components for the typical installation including a Cisco Controller (such as the 
Cisco Smart+Connected Controller 250).

See the “Install and Connect the Physical Components” section on page 4-1.
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Summary Steps
Complete the following steps to create a project template that can be loaded onto multiple Cisco 
Controllers. 

Task

Step 1 Install the Control4 Composer Pro Software.

Step 2 Register the Cisco Controller and create a registration code, if necessary.

Create a consumer account on the dealer portal and register the Cisco Controller to obtain the 
registration code you will copy into Composer software in Step 9.

Step 3 Launch the Composer Pro software on your PC and select the Cisco Controller name.

Step 4 Rename the project.

Step 5 Add the locations that represent the physical layout of the residence.

Step 6 Add the primary Cisco Controller to the project.

Step 7 Identify the Cisco Controller as the primary Controller.

Step 8 Enter the project properties.

Step 9 Register the primary Cisco Controller to enable software upgrades and other services.

Step 10 Enable the ZigBee Server on the primary Controller.

Step 11 Add additional devices from the default My Drivers tab.

Step 12 Add additional device drivers from the Driver Database (Local or Online), if necessary

Step 13 Identify each networked device.

Step 14 Update the device software.

Step 15 Create the Virtual Connections for Control (Serial) and Audio/Video Devices.

Step 16 Verify and configure light switches and dimmers.

Step 17 (Optional) Save the project as a template.

Step 18 (Optional) Add additional devices to the template.

Step 19 (Optional) Configure an intercom for communication within a residence.
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Overview of the Composer Pro Configuration Tool
The Cisco Controller enables automation within the residence. Multiple Cisco Controllers can be 
installed in a residence, but only one device (known as the primary Controller) runs the Director. 
Director is a pre-installed Linux based software package embedded in the device that communicates with 
Cisco and third-party products to enable device interaction and automation features.

Refer to the following topics for more information:

 • Connecting to a Director, page 5-4

 • Composer Pro Overview, page 5-6

 • Install the Composer Pro Software, page 5-7

Connecting to a Director
Composer Pro is the software used to connect to and program the Director that resides on the primary 
Controller. When you launch Composer Pro, you are prompted to select one of the following options 
(Figure 5-1).

Figure 5-1 Connecting to a Director

 • Virtual Director—Allows you to configure the project without being connected to a Director 
(Cisco Controller). Changes are saved on the PC, and can be uploaded to a Director later. Choose 
this option to work on a project when you are disconnected from the network. You can do almost 
everything you need to set up and design a system, set up most connections, and use programming. 
You cannot identify network connections, test device control, or set up media using this method. See 
the Composer Pro User Guide for information.
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 • Director on Local Network—Allows you to connect to a Director (Cisco Controller) that is 
available on the same network (inside the firewall). Changes are automatically saved to the Cisco 
Controller and are effective immediately. You can set up and design the project, make connections, 
add media, and program the system using this method. The project can also be backed up and used 
as a template to configure additional Cisco Controllers

 • Remote Director—A remote live connection to the Cisco Controller over the Internet (the PC is 
outside the network firewall). Changes to the system are effective immediately. Choose this option 
to use an Internet connection to the residential network. See the Composer Pro User Guide for more 
information.

Note If a “Renew Composer Registration” appears, type your email address, password, and click Renew. See 
your Cisco representative and the Cisco Smart+Connected Residential Licensing and Registration Guide 
for more information.
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Composer Pro Overview
After connecting to the Director (Figure 5-1) you must add the devices used in the system, and configure 
the features available to those devices. 

Figure 5-2 summarizes the main Composer Pro user interface elements. See the “Create the Basic Cisco 
Controller Project” section on page 5-1 for instructions to create a project and (optionally) save it to a 
template.

Figure 5-2 Composer Pro Overview

1 System Design—(Default View). Contains the project tree where you build or update the project 
configuration with locations and device objects. Double-click an object in the Items pane (see 
'Items' in this list) to add it to the project tree in the System Design pane
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Install the Composer Pro Software
To install the Composer Pro software, you must have a dealer account and access to the Internet.

Procedure

Step 1 Verify that your administrator has created your dealer account and enabled access to the Composer Pro 
software.

Step 2 Log in to the Cisco Developers Network (CDN) to download the installer file.

Step 3 Double-click the installer file on your local disk.

Step 4 Follow the on-screen instructions to install the Composer Pro software.

Note You will be prompted to install the Microsoft .NET Framework, if necessary. 

Step 5 Enter your dealer credentials (username and password) to enable the Composer Pro software.

Note The PC must be on the same subnet as the Cisco Smart+Connected Residential components, including 
the primary Cisco Controller.

2 Properties—Contains the Properties of an object you select from the project tree when you want 
to check or modify a device, project, and room. For more information about the Properties pane, 
select the Help menu and search for Project Properties, Room Properties, or Device Properties.

3 Items —Contains the items (or objects) you use to build your project, such as locations (sites, 
buildings, floors, rooms) and devices (Controller hardware, DVDs, TVs, Receivers, lights, 
contacts, relays, etc.). If a device is not available in the My Drivers tab of this pane, use the 
Search tab to search for that device (see the Composer Pro User Guide - Advanced topics for 
information about drivers). If you've created a new driver using the Driver Wizard (DriverWorks 
The DriverWorks SDK is used to create two-way drivers for audio video (AV) and non-AV 
devices.), you will find your new driver in the Search tab. 

4 Views—Select a view to change the appearance and functionality of the Composer Pro interface. 
The changes reflect the configuration options for that view.

 • System Design—Lets you build the project tree and identify the devices to the system. 

 • Connections—Lets you identify all connections (Room, Control, AV, Network).

 • Media—Lets you add and scan stored or broadcast media.

 • Agents—Lets you set up an agent for use in the system and in programming. Agent types: 
Lighting Scenes, Wakeup, Scheduler, Variables, etc. For more information, see the see the 
Composer Pro User Guide and the “Understanding Agents” section on page 7-7.

 • Programming—Lets you program devices and agents on the system. For more information, 
see the see the Composer Pro User Guide and the “Programming Basics” section on page 7-9.
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Create the Basic Project Configuration
The basic project configuration includes the project properties, such as the project name, and the location 
and time settings where the project will be installed. The basic configuration also include the device 
drivers for the residential automation equipment, such as the Cisco Controller, displays, ZigBee lighting, 
and other option devices. After the device derivers are added, you must identify the devices in the 
Composer Pro project. If you are adding audio/video (A/V) equipment, such as a television, DVD player 
or stereo, you must also define the A/V connections and endpoints.

Refer to the following topics for more information, and instructions to create a basic Composer Pro 
project.

 • Devices Added in This Example, page 5-8

 • Before You Begin, page 5-9

 • Create the Project and Add Devices, page 5-9

 • Create the Virtual Connections for Control (Serial) and Audio/Video Devices, page 5-25

Devices Added in This Example
The instructions included in this sample are for a standard set of Cisco and third-party automation 
devices. The actual devices used in your deployment and template will vary.

The devices used in the instructions include the following:

Cisco Controller 

 • Cisco Controller 250

Networking

 • Cisco 8-Port PoE Switch

 • Cisco Wireless Router

Displays

 • Cisco In-wall Display

 • Cisco Portable Tablet

Door Stations

 • Cisco External Video Door Station

Remote Control

 • Cisco Universal Remote 250

Audio/Video

 • Television

 • USB stick

 • Speakers

HVAC

 • Wireless thermostat
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Keypads

 • 6-button keypad

Lighting

 • Dimmer

 • Switch

Other

 • Motion sensor

 • Door lock

 • IP security camera

Before You Begin
 • Disable the security features on your PC. They may interfere with your ability to connect to the 

Cisco Controller.

 • Ensure that your PC and the Cisco Controller are on the same network subnet. For example, they 
should be connected to the same router or switch.

 • Create the Consumer accounts and Cisco Controller registration codes used to register the Cisco 
Controller. See the Cisco Smart+Connected Residential Licensing and Registration Guide for more 
information.

Create the Project and Add Devices
Complete the following procedure to create a new project, configure the project properties, and add and 
identify the supported devices. These instructions use a standard set of residential automation 
equipment. The actual devices used in your deployment will vary.

Procedure

Step 1 Launch Composer Pro and choose the Cisco Controller.

a. Choose Start > All Programs > Control4 > Composer 2.2.x. (or higher)

b. If prompted, enter your dealer credentials (username and password) to register or renew your 
Composer license.

c. Select “Director on Local Network”.

d. Highlight the Cisco Controller name (or IP address) and click Connect.

Note If the Cisco Controller does not appear in the list, review the “Before You Begin” section on 
page 5-9. Also verify that the Cisco Controller and networking equipment was properly installed 
and configured. See the “Install and Connect the Physical Components” section on page 4-1.

e. Click Yes to add the Cisco Controller to your list of trusted devices.

This step is only necessary the first time you connect your PC to a Cisco Controller. 
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f. If prompted to update the device software, click OK.

Tip We recommend that you do not perform the upgrade until all devices have been identified in the 
project (see Step 9 through Step 13). This will cause all devices to be upgraded at the same time. 
If you upgrade the Cisco Controller before the other network devices are added and identified, 
each device will automatically upgrade when identified the device will be unresponsive during 
the upgrade process.

Step 2 Rename the project.

a. Right-click the project name and select Rename.

b. Enter a meaningful name that describes the template purpose. For example: 2-room template.

Figure 5-3 Renaming the Project

Step 3 Add the locations that represent the physical layout of the residence (Figure 5-4).

For example, if you are creating a template for a 2-room residence, add Room 1 and Room 2:

a. Select the Locations tab (Figure 5-4).

b. Double-click Room to automatically add the room. When you add the first room, a default hierarchy 
is also created (for example: Home > House > Main > Room).

c. (Optional) Add additional rooms if necessary. The room is added as a sub-location to the selected 
location.

For example, highlight Main and double-click Room to add a second Room 2. 

d. (Optional) Right-click the icons and Rename the locations, if necessary.
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Figure 5-4 Adding Locations

Step 4 Add the primary Cisco Controller to the project.

Note The Cisco Controller is the main device that enables residential automation. A residence can 
include multiple Cisco Controllers, but the Cisco Controller that runs Director is referred to as 
the primary Cisco Controller. The first Cisco Controller to be added to the project is the primary 
Controller by default.
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Figure 5-5 Adding the Primary Cisco Controller

a. Highlight the room where the Cisco Controller will be installed.

b. From System Design, choose the My Drivers tab (Figure 5-5).

c. Double-click the Cisco Controller driver to add the device. 

For example, Home Controller HC250.

d. Verify that the Cisco Controller appears in the correct location (Figure 5-5).

Tip Additional drivers related to the Cisco Controller (such as Internet Radio and Digital Media) are 
added automatically.

e. (Optional) Right-click on the Cisco Controller name and room names to rename the device and 
location tree.

For example, change the Cisco Controller name to Primary Controller.
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Step 5 Identify the Cisco Controller as the primary Controller (Figure 5-6).

Figure 5-6 Identifying the Primary Controller

a. Click Connections.

b. Click the Network tab.

c. Highlight the Cisco Controller.

d. Click Identify.

e. Press the physical Link or ID button on the Cisco Controller, as shown in the Composer Pro image 
(the button may be on the front or the back of the device, depending on the model).

f. Verify that the Cisco Controller network address appears in the entry field, as shown in Figure 5-6.

g. Click Close.

Step 6 Enter the project properties (Figure 5-7).

Note Be sure to enter the correct date, time and timezone for your Cisco Controller, or some device functions 
that require network and device communication may not operate correctly. For example, if the default 
project year 2000 is not changed, then the Cisco Controller will not register.
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Figure 5-7 Project Properties

a. Click System Design.

b. Select the project name in the top left of the screen.

c. Under Properties, enter a new Name, and click Set.

For example, 1 Bedroom Template

d. Click Lookup to enter the location where the equipment will be installed.

For example: Songdo, South Korea.

e. Enter the Time and Date where the equipment will be installed.

f. Click Edit to change the time zone.

Note Changing the time zone causes the Cisco Controller to reboot.

Step 7 Register the primary Cisco Controller to enable software upgrades and other services.

Note To register the Cisco Controller, a consumer account must be created and used to generate a 
registration code. See the Cisco Smart+Connected Residential Licensing and Registration Guide 
for more information.

a. Select Tools > Account Services (Figure 5-8). 

b. Enter the Cisco Controller registration code (see the Cisco Smart+Connected Residential Licensing 
and Registration Guide for more information).
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c. Verify that Enable Remote Access is selected. This option allows remote troubleshooting.

d. Click Register.

e. Click Close.

Figure 5-8 Register the Controller

Step 8 Enable the ZigBee Server on the primary Controller.

Figure 5-9 ZigBee Server Configuration

a. Click System Design.
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b. Highlight the primary Controller.

c. In the Properties tab, click Edit ZigBee Configuration.

d. Click Yes to create a new ZigBee network.

e. Click OK to accept the default ZigBee Server and ZAP Coordinator (ZigBee Network Settings).

f. Click OK again to accept the additional default ZigBee Network Settings, including the Server, 
Channel, and Coordinator).

g. Select File > Refresh.

h. To verify that the ZigBee Server is Running, click System Design, highlight the primary Controller, 
and verify that the ZigBee Server is Running. (Figure 5-9).

Step 9 Add additional devices from the default My Drivers tab.

Tip My Drivers includes the supported device drivers included with the Composer Pro installation. 
Use the Search tab to locate additional drivers from the Online Database (Step 10), or drivers 
saved to your PC Local Database (Step 11). 
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Figure 5-10 Adding Device Drivers

a. In the System Design view, highlight the room where the device is installed.

For example: select Family Room

b. Choose the My Drivers tab (Figure 5-10).
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c. Double-click the driver name for each device to be added to the project. 

 – Rename each device and drag it to the correct room that represents the device physical location.

 – Figure 5-10 shows a sample project with the devices described in the following sample device 
set.

 – Table 5-2 describes a sample set of device drivers used in a typical residence.

Table 5-2 Sample Device Driver Set 

Driver Name / Device Type Driver Category Description

 • Wireless Dimmer

 • Wireless Switch

Lighting We recommend renaming each driver since they are automatically added as 
“Light”. For example, name the device drivers: “Wireless Dimmer” and 
“Wireless Switch”.

 • System Remote 
Control SR-150

 • System Remote 
Control SR-250

User Interface The Cisco Universal Remote 250 includes an LED interface. The Cisco 
Universal Remote 150 does not.

InfinityEdge 7” Touch 
Screen

User Interface Add each Cisco In-wall Display included in the project. 

For example, if the project will have three Cisco In-wall Displays, add three 
copies of the driver, move them to the rooms where they will be installed, 
and rename the devices (for example, Right Wall Touch Screen, Middle Wall 
Screen, etc.).

Portable 7" Touch Screen 
V2

User Interface Add each Cisco Portable Tablet included in the project. Rename the devices 
if necessary (for example, as Portable Tablet).

 • MyHome - iPhone

 • MyHome - iPad

 • MyHome Android

 • MyHome - PC

User Interface (Release 2.2 only. In release 2.3 and higher the smart devices are 
automatically added when the user logs into their account with a smart 
device or PC).

Add the mobile and desktop devices that will use the Cisco SC Residence 
App to connect with the Cisco Smart+Connected Residential Solution.

Note The MyHome drivers enable smart device and PC functionality and 
connectivity in the project. 

Note A Cisco Smart+Connected Smart Device license must also be 
purchased and added to the Consumer account associated with the 
primary Cisco Controller. See the Cisco Smart+Connected 
Residential Licensing and Registration Guide for more information.

 • 3-Button Keypad

 • 6-Button Keypad

User Interface In-wall keypads that can be programmed to trigger a variety of tasks, such 
as lighting scenes.

Door Station User Interface The door station allows residents to monitor and communicate with visitors 
at their front doors or entryways.

Dual Relay Blind Motorization > 
Blinds

Motorized blinds can automatically lower and raise a window shade.
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Television Audio Visual A pop-up window appears when the Television driver is added. Select the 
TV model from the local or online database. The television driver defines the 
physical ports on the device, and the infrared (IR) codes that correspond to 
the Cisco Universal Remote buttons.

For example, select the manufacturer “Coby” and model “LEDTV-1526”. 

Note Additional drivers for the television capabilities will be 
automatically added. For example, Cable TV.

Tip If a driver for the television model is not available, see “Creating an 
IR Television Driver” in the Composer Pro User Guide (click the 
link, select the Search tag, and search for “Creating an IR Television 
Driver”). See also the “Overview of Creating Device Drivers” and 
“Using the Driver Wizard” topics.

<Camera Model> IP Cameras Select a camera model from the list. For example, the Panasonic Fixed Field 
Camera.

IP cameras can display video based on a set of configured rules.

Residential Thermostat HVAC A wireless thermostat used to control the residence heating and air 
conditioning system.

Table 5-2 Sample Device Driver Set (continued)

Driver Name / Device Type Driver Category Description
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Step 10 Add additional device drivers from the Online Database, if necessary (Figure 5-11). 

The Online Database includes supported drivers that are available from the online respository. Your PC 
must be connected to the Internet to access the Online Database.

Figure 5-11 Adding Drivers from the Online Database

The following example is for a ZigBee wireless door lock.

a. Click the Search tab (Figure 5-11).

b. Select Online Database.

c. From Device Type, select Others.

d. From Manufacturer, select Black & Decker.

e. Double-click Black & Decker Smartlock RF ZigBee.

f. Wait for the driver to download and install.

Step 11 Add additional device drivers from the Local Database, if necessary (Figure 5-12). 

 • The Local Database includes drivers that you previously acquired and copied to the following 
directory on your PC: 
C:\Users\<user>\Documents\Control4\Drivers

 • To add a new driver to the Local Database, select Add Driver from the Driver menu. Select the .c4i 
driver file from a local or network drive and click Open. 
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 • See your system administrator or Cisco support representative for more information on obtaining 
the required driver files.

Figure 5-12 Adding Drivers from the Local Database

The following is an example to add a motion sensor driver.

a. Click the Search tab.

b. Select Local Database (Figure 5-12).

c. From Device Type, select Motion Sensor.

d. From Manufacturer, select All.

e. Double-click Card Access Wireless Motion Sensor.

Tip If there is no available IR driver for the device you are adding to your project you can create a new driver 
or modify an existing one. Use the device remote control to learn IR commands into a new driver. For 
more information see the following topics in the Composer Pro User Guide: “Creating IR-Controlled 
Drivers”, “Programming Using IR Inputs with Third-Party Remotes”, and “Creating an IR Television 
Driver”.
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Step 12 Identify each networked device (Figure 5-13).

All Wi-Fi and ZigBee devices must be identified to establish communication with the Composer Pro 
project. 

Note The primary Cisco Controller was previously identified in Step 5.

Figure 5-13 Identifying Networked Devices

a. Click Connections.

b. Select the Network tab.

c. In the IP Network Connections list (center pane), select the first device and click Identify.

d. When prompted, press the bottom on the device as instructed in the pop-up window (Figure 5-13).

Examples:

 – Cisco In-wall Display—Press the right button on the lower-right edge.

 – Wireless switch—press the top button four times.

 – Cisco Universal Remote—press the red button four times.

Tip If an animation is not available, refer to the device documentation for the button sequence or 
other method used to join the device to the ZigBee network.

Tip You can create the connection by dragging a device from the “Available Devices” (on the right 
side) onto the device in the “IP Network Connections” window.

e. When the device address displays in the Composer Pro field, click Next.
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f. When all devices are identified, click Close.

Tip • Wi-Fi devices typically require a single button press. ZigBee devices require four button presses. To 
identify ZigBee devices, the ZigBee server must be running, as described in Step 8. 

 • Mobile and PC devices require a Cisco smart device license. See the Cisco Smart+Connected 
Residential Licensing and Registration Guide and the Cisco Smart+Connected Smart Device 
License for Real Estate Developers for more information.

 • If you upgraded the Cisco Controller software in Step 1, the device firmware may automatically 
upgrade when identified. The device may be unresponsive during the upgrade process.

Step 13 Update the device software.

Tip We recommend performing the update after all devices have been identified in the project (see 
Step 9 and Step 12). This causes all devices to be upgraded at the same time. If you upgrade the 
Cisco Controller before the other network devices are added and identified, then each device will 
automatically upgrade when it comes online and the device may be unresponsive during the 
upgrade process.

a. Select the menu Tools > Update Manager.

b. Click Update.

c. Click Advanced (Figure 5-14).

d. Click Edit.

e. Enter the following URL (or verify that it was previously changed): 

http://services.control4.com/Updates-cisco/v2_0/Updates.asmx

f. Click OK.

g. Verify that the version is “Cisco”, and select a version number, if necessary.
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Note If the URL is incorrect, the version selections will be blank. You must verify that “Cisco” and a 
version number appears (Figure 5-14). Failure to update this URL correctly can cause an 
incorrect software release to load, and the loss of supported services.

Figure 5-14 Updating the Device Software

h. Click Begin Update.

i. Follow the on-screen prompts to update all identified devices.

Step 14 Continue to “Create the Virtual Connections for Control (Serial) and Audio/Video Devices”.
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Create the Virtual Connections for Control (Serial) and 
Audio/Video Devices

The Control and A/V connections in Composer Pro represent the physical cables connected from the 
Cisco Controller to other devices, and between the various devices. The connections define the 
communicate path for signals from A/V, IR, Relay, Contact, and/or serial devices.

For example:

 • Video connections define the path of video signals.

 • Audio connections define the path of audio signals.

 • Control connections define how the Cisco Controller communicates with the device.

Each connection also includes an endpoint, which is the final destination of the audio or video signal, 
and the device/port where that signal will play. 

For example:

 • The video endpoint of a DVD player would be the television.

 • The audio endpoint of the DVD player could be the same television, or an audio receiver if a home 
theater is installed. 

Note The type and number of connections depends on the physical port. For example, an HDMI cable 
can provide the path for both audio and video signals, while a component connection uses a 
different cable for audio and video signals.

Examples

 • An HDMI cable connected from the Cisco Controller to the TV allows the Cisco Controller to 
display the On-Screen Navigator on the TV.

 • An IR emitter connected from the Cisco Controller to the TV allows the Cisco Controller act as the 
remote for the TV (when a button on the Cisco Universal Remote is pressed, the command is sent 
to the TV via the Controller’s IR emitter).

 • An HDMI cable connected from a DVD player to the TV allows the TV to display audio and video 
from the DVD player.

 • An IR emitter connected from the Cisco Controller to the DVD player allows the Cisco Controller 
to send IR commands to the DVD player (when a button on the Cisco Universal Remote is pressed, 
the command is sent to the DVD player via the Controller’s IR emitter).

Summary Steps

To enable control and A/V connections, do the following:

1. Create the design that specifies the physical device connections between the A/V and control (serial) 
devices. See the “Create a Single Line Drawing” section on page 2-12.

2. Install the devices and connect the physical wires according to the single line drawing. See the 
“Install and Connect the Physical Components” section on page 4-1 for more information. 

3. Create the virtual connections in Composer Pro that replicate the physical connections 
(Figure 5-15). See the “Procedure to Create the Virtual A/V and Control Connections” section on 
page 5-26.
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Figure 5-15 Control and Audio/Video Connections

Procedure to Create the Virtual A/V and Control Connections

Step 1 Click Connections.

Step 2 Click the Control A/V tab.

Step 3 Highlight an output device. 

For example, the primary “Home Controller HC250”.

Step 4 Highlight a connection in the top pane, and drag-and-drop it to appropriate device and port in the bottom 
pane (Figure 5-15). 

For example, Table 5-3 defines a sample set of physical connections between the Cisco Controller and 
the TV. Select the Cisco Controller to define the Cisco Controller output ports, that connect to device 
input ports.

Table 5-3 Sample Cisco Controller and Audio/Video Connections

Cisco Controller Output Component Input Device

Video Output (Component HD) TV Component Input

Audio Out 1 TV Component Input

IR Out 1 TV IR Sensor
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Note Table 5-3 is an example only. The connections will vary depending on the equipment used.

Step 5 Verify the Control and Audio/Video Connections.

a. Click Connections.

b. Click the Control A/V tab.

c. Select a room. 

For example, the Living Room or Bedroom.

d. A summary of the Control and Audio/Video Connections endpoints is displayed (Figure 5-15). 

Endpoints are the destination for control and Audio/Video signals.

Figure 5-16 Control and Audio/Video Endpoints

For example, Table 5-4 describes the purpose of the endpoints shown in Figure 5-16.

Table 5-4 Room Endpoints

Endpoint Connected To Description

Video End Point Big TV The Navigator video sent out from the Cisco 
Controller will be displayed on the “Big TV”.

Audio End Point Big TV Audio sent out from the Cisco Controller will be 
played on the “Big TV”.

Note Audio could also be sent to other devices, 
such as an amplifier/receiver.
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e. Drag the On-screen Device endpoint to the Cisco Controller. This will enable the Navigator 
controls to display.

Step 6 Continue to the “Saving the Project as a Template” section on page 5-31.

 • Video’s Audio 
Endpoint

 • Video Volume

 • Audio Volume

Big TV  • The audio associated with video is sent to the 
“Big TV”.

 • The Video Volume and Audio Volume changes 
are sent to the “Big TV”.

Note These endpoints are added automatically.

On-screen Device Primary Cisco 
Controller 

Causes the Navigator user interface to be displayed 
by the Cisco Controller on the assigned video output 
device.

Note This endpoint is added automatically.

Table 5-4 Room Endpoints

Endpoint Connected To Description
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Verifying and Configuring Lighting Switches and Dimmers
You can manually verify that the Composer Pro project can successfully control a lighting switch or 
dimmer. This ensures that the device driver was successfully added to the project is communicating over 
the ZigBee mesh network. 

Note The following example is for standard Control4 lighting products connecting to the system via ZigBee 
wireless. Products from other lighting manufacturers may use different connections (i.e. RS232); the 
drivers and configuration may appear and operate differently that the following example.

After you verify the switch or dimmer connectivity, you can configure additional properties for the 
lighting device.

Procedure

Step 1 Select System Design and add the driver for the wireless light switch or dimmer, as described in the 
“Create the Basic Project Configuration” section on page 5-8.

Step 2 To open the controls, double-click the lighting driver that was added to the system design.

For example, double-click the “Room 1 light” shown in Figure 5-17.

Step 3 Use the available controls to turn the light on or off or control the light level. 

Figure 5-17 Verifying a Lighting Connection
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Step 4 Configure additional properties for the switch or dimmer.

 • For example, you can define the number of seconds that a dimmer takes to ramp up or down, the 
“Preset Level” of load to which the dimmer ramps when turned on, the LED colors displayed on the 
switch or dimmer, and other options.

 • See the “Configure a Wireless Switch or Dimmer or an Inline Dimmer” properties of the Composer 
Pro User Guide. See Figure 5-18 for more information.

Note The options and controls available on a lighting device vary depending on the manufacturer and 
model. See the device documentation for more information.

Figure 5-18 Configuring a Switch or Dimmer

Step 5 Click Apply To... to apply the changed settings to other lighting devices in the system by room.

Step 6 Click Set to save the setting at the device.

Related Documentation
For additional information, see the following topics in the Composer Pro User Guide. 

 • Configuring Lighting and Keypads

 • Configure a 2, 3 or 6-Button Keypad

 • Configure a Puck Dimmer or Switch Module

 • Configure a Wireless Outlet Dimmer
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 • Configure a Wireless Outlet Switch

 • Configure a Wireless Outlet Switch for Power Sensing AV Devices

Saving the Project as a Template
Saving a Composer Pro project as a template allows you to upload the project configuration to other 
Cisco Controllers. This is especially useful in multi-dwelling units (MDUs) equipped with a large 
number of similar Cisco Smart+Connected Residential Solutions. For example, a deployment might 
offer three basic packages: a bronze package with a basic set of features and devices, a silver package 
that includes additional options, and a gold package that includes the full set of possible features. 

To simplify the configuration and deployment of these packages, you can create bronze, silver and gold 
projects, and then backup each project to a .C4P configuration file. You can then use the Cisco 
Smart+Connected Remote Management Solution (Cisco RMS) to deploy the .C4P template file to 
multiple Cisco Controllers. The upload process removes all user information and device-specific 
information so the same settings can be applied to multiple Cisco Controller without conflict.

See the Cisco Smart+Connected Remote Management Console Administration Guide for more 
information on deploying multiple Cisco Controllers in multi-dwelling units (MDUs).

Note The project template does not include configurations that must be applied in the residence, such as 
identifying network devices in the project, and other tasks. See the Cisco Smart+Connected Remote 
Management Console Administration Guide for more information.

Procedure

Step 1 Create the Cisco Controller project using Composer Pro as described in the “Create the Basic Project 
Configuration” section on page 5-8. 

Step 2 Backup the .C4P project file.

f. Choose File > Backup As.

g. Enter a file name and location and click Save.

Tip The default file backup location is C:\Users\<username>\Documents\Control4\Projects.

Step 3 Upload the project file to the Cisco RMS Console, as described in the Cisco Smart+Connected Remote 
Management Console Administration Guide. 

Refer to the following additional topics:

 • Creating Controller Templates

 • Adding Controllers to Cisco RMS

 • Applying General Attributes to Controllers

 • Completing the In-Residence Tasks
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Where To Go Next
 • Adding Additional Devices to the Template, page 6-1

 • Configuring the Intercom for Communication Within a Dwelling, page 7-1
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Adding Additional Devices to the Template

After the basic project template is created, you can add additional devices to the project. Refer to the 
following topics for more information. 

Contents

 • Summary Steps, page 6-1

 • Add Access for Mobile Devices and PCs, page 6-2

 • Adding Media From External Storage Devices, page 6-6

 • Adding a Network Camera, page 6-12

 • Adding a Wireless Thermostat, page 6-13

 • Where To Go Next, page 6-14

Summary Steps
Complete the following steps to add additional devices and services to an existing project template. 

Task

Task 
Complete? 

( )

Step 1 Create the basic project.

See the “Create the Basic Cisco Controller Project” section on page 5-1

Step 2 Add additional devices and features as described in the following topics.

See Contents, page 6-1

Step 3 Customize the project.

See the “Configuring the Intercom for Communication Within a Dwelling” section on 
page 7-1

Step 4 Save the project as a template file.

See the “Saving the Project as a Template” section on page 5-31
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Add Access for Mobile Devices and PCs
The following components are required to enable smart device access to a Cisco Smart+Connected 
residence:

 • Cisco Smart+Connected Smart Device license—This license must be purchased for each primary 
Controller.

 • MyHome license—The dealer must apply the MyHome smart device license to the Consumer 
account (the Consumer account is associated with the dwelling primary Cisco Controller. 

 • MyHome device drivers—(Release 2.2 only) A driver must be added to the project for each smart 
device or PC that will access the residencial system. This step is not necessary if the Cisco 
Controller is running release 2.3 or higher.

 • Cisco SC Residence App—Residents must install the smart device app onto each smart device or 
PC. Residents log in to their residential system using the Consumer account credentials.

Once complete, the user can use their smart device or PC to access the Navigator for the residence.

Note The Navigator is the menu that appears on a TV, touchscreen, PC or smart device.

Summary Configuration Steps

Task

Task 
Complete? 

( )

Step 1 Purchase a Cisco Smart+Connected Smart Device license for the dwelling. 

 • Smart device licenses can be perpetual (no expiration) or subscription-based (valid 
for 365 days).

 • Licenses can be purchased in bulk.

 • See the and the Release Notes for the Cisco Smart+Connected Residential Solution 
for more information.

Step 2 Enable the MyHome license on the Consumer account associated with the primary 
Controller in the dwelling. 

See the Cisco Smart+Connected Residential Licensing and Registration Guide for more 
information.

Step 3 From the PC or smart device, download the Cisco SC Residence App from the 
appropriate app store.

See the and the Release Notes for the Cisco Smart+Connected Residential Solution for 
more information.

Step 4 (Release 2.2 only) In Composer Pro, add drivers for each smart device or PC to the 
dwelling project (or project template).

Note In release 2.3 and later, the smart device is automatically added to the project 
when the user logs in to the Cisco SC Residence App for the first time.
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Procedure

Step 1 Enable the occupant’s Consumer account.

a. Purchase the Cisco Smart+Connected Smart Device license.

a. Add the MyHome smart device license to the Consumer account. 

Note See the and the Release Notes for the Cisco Smart+Connected Residential Solution for more 
information. 

Step 2 Synchronize the newly-added licenses that were associated with the Consumer account (using the dealer 
portal). 

This causes the Cisco Controller to retrieve assigned licensing from the remote access licensing service. 

Cisco Controllers automatically check in on a regular schedule, but you should manually check in to 
apply the licenses immediately. 

a. Start Composer Pro and connect to a Director (the primary Cisco Controller).

b. From the menu bar, select Tools > Account Services.

c. On the Account Services dialog, click Check in.

d. When the status indicator changes to “Check in successful” the subscription information is 
synchronized and the devices can be authenticated.

Step 3 Download the Cisco SC Residence App.

 • From the mobile device or PC/Tablet, either you or the device owner can go to the iTunes or Google 
Play app store to download the app. Follow the online instructions to download the app(s).

 • To download the PC application, see the instructions for your release in the Release Notes for the 
Cisco Smart+Connected Residential Solution . 

Step 4 (Release 2.2 only) Add the device driver to the project (Figure 6-1).

a. In Composer Pro, select the System Design view and highlight the room where you want to add the 
drivers. For example, the same room as the primary Controller.

b. Click the My Drivers tab (in the Items column on the right).

c. Expand the User Interface folder.

d. Double-click the smart device, tablet and PC drivers to add them to the selected room.

Step 5 Log on to the Cisco SC Residence App using the Consumer account registered to the 
primary Cisco Controller in the residence.

Step 6 (Release 2.2 only) Use the Cisco SC Residence App to identify the PCs and smart 
devices in the Composer Pro project.

Note In release 2.3 and later, the smart device is automatically added to the project 
when the user logs in to the Cisco SC Residence App for the first time.

Task

Task 
Complete? 

( )
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Note In release 2.3 and later, the smart device is automatically added to the project when the user logs 
in to the Cisco SC Residence App for the first time.

Figure 6-1 Smart Device and PC Drivers (Release 2.2 Only)

 – MyHome - iPhone. Use for iPhone or iPod Touch mobile devices.

 – MyHome - iPad. Use for iPad mobile devices.

 – MyHome - Android. Use for Android mobile devices.

 – MyHome - PC. Use for PC or Mac.

Tip In My Drivers, right-click and choose Restore Default List to update the list of MyHome 
drivers.

Step 5 (Release 2.2 only) Identify the device in Composer Pro (Figure 6-2).

a. Click the Connections view, and then click the Network tab.

b. Double-click the device name (or the driver you added). The Identify dialog box opens and provides 
instructions to identify your device.

c. Press the appropriate button on the device (see figure below) to identify it to the system.
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Note In release 2.3 and later, the smart device is automatically added to the project when the user logs 
in to the Cisco SC Residence App for the first time.

Figure 6-2 Identify a Smart Device in Composer Pro

Step 6 Using the PC or smart device, log in to the Cisco SC Residence App to access the Cisco 
Smart+Connected Residential Solution features.

Troubleshooting Tips for Mobile Device Connectivity
If you experience problems identifying a mobile or PC device: 

 • Confirm that you’ve properly added the correct license for that device in the correct Consumer 
account. See the Cisco Smart+Connected Residential Licensing and Registration Guide for more 
information.

 • Confirm that the Cisco Controller has checked in and has “learned” about the license entered in the 
Consumer account. 

 • (Release 2.2 only) Confirm that you’ve added the correct device driver to your project. For example, 
an iPhone won’t identify properly if you use an iPad driver See Step 4.

 • You should have a Wi-Fi Access Point (WAP) or router connected to and configured to operate on 
the same IP network or LAN as the Cisco Controller. Confirm that the device is communicating on 
the same network as the Cisco Controller.
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Adding Media From External Storage Devices
You can store and access digital audio and video files from an external storage device for playback on 
connected speakers or a video or audio endpoint. Audio files can be played on powered speakers 
connected to the Cisco Controller, through a receiver (such as a home theater system), or other audio 
endpoint. Video files can be played using an additional media encoder such as an AppleTV or Control4 
Media Player. Media is selected using the Navigator interface that appears on a Cisco touch screen, 
television, or mobile device (using a Cisco SC Residence App).

Examples of external storage devices include USB flash drives, powered USB external hard drives, 
external serial ATA (eSATA) drives, or a shared network storage area (such as a NAS drive or a 
computer’s hard drive). 

Refer to the following topics for more information:

 • Requirements, page 6-6

 • Attach and Scan External USB Storage Devices, page 6-6

 • Access and Scan Network Storage Devices, page 6-7

 • Define a Scanning Schedule, page 6-10

 • Related Documentation, page 6-11

Requirements
 • USB flash drives or USB external hard drives must be formatted as FAT32 devices.

 • Only externally powered USB drives are supported. Self-powered USB drives are not supported.

 • USB storage devices can only use one (1) partition with a 2TB maximum size. 

 • Shared drives on a Windows system cannot contain a space in the directory/pathname.

 • When you disconnect the external drive (USB, network, etc.) from the system, the music is no longer 
available. Reconnecting the external drive makes the media available again.

Note You can also use the Media view to view and select Internet radio, or add stored music and media 
collections from a DVD Player or Disc Changer, broadcasts, channels, and stations. See the “Setting Up 
Media” section of the Composer Pro User Guide for and the “Media View” section of the Composer Pro 
Getting Started Guide for more information.

Attach and Scan External USB Storage Devices
Complete the following procedure to attach and scan external storage devices using a USB connection. 
Scanning the device creates an index of the files, and accesses an online database to update media 
artwork and other information.

External storage devices must have media stored in unprotected MP3 format.

Procedure

Step 1 Attach the storage device to the Cisco Controller. 

 • If using a USB stick, insert the stick.
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 • If using a USB hard drive, you must connect the drive and also connect the drive to a power source. 

 • You can also connect an eSATA drive to some Cisco Controller models.

Step 2 Click Media.

Step 3 In the project tree, select the external device.

Step 4 Click Scan in the device's pane.

You can add media from the external storage device when it is connected to the Controller. However, it 
is recommended that you connect your external drive directly to the PC where you want to copy the 
media. When scanning, the media appears on the device.

Access and Scan Network Storage Devices
To access and scan network storage devices, you must first add the device driver in Composer Pro. Once 
the device is added to the Composer Pro project, you can scan the device for available media files. 
Scanning the device creates an index of the files, and accesses an online database to update media 
artwork and other information.

Note The network location must be an open share location (no password required).

Procedure

Step 1 As appropriate, use the documentation provided with your operating system to create a shared network 
drive.

Example: Using Windows XP to make a local C:/ Drive directory available on the network, right-click 
the folder and select Sharing and Security. Click the Share this folder button.

Step 2 Click System Design.

Step 3 From the My Drivers tab, double-click Network File Storage to add it to the project tree (Figure 6-3).

Step 4 Highlight Network File Storage in the project tree, and configure the user name, password, and 
workgroup (or domain) for the network file share, and then browse to its network location.

Note This information varies between media storage types. 
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Figure 6-3 Add a Network File Storage Driver

Step 5 Click Media (Figure 6-4).

Figure 6-4 Scanning Media

In Network File Storage, notice the options: Audio Media and Video Media.
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Step 6 To add or scan audio files, select Audio Media, and then click New or Scan.

 • When adding music to Network File Storage from the desktop, the music folder must reside in My 
Network Places so components can access the music files. A mapped network drive is not 
applicable in this situation.

 • Audio files must be in one of the following formats to be scanned and played: WAV, MP3 or FLAC. 
If you connect an iPod or another audio device, the Control4 system can play back the files 
supported on that device; but only MP3 files can be decoded.

Step 7 Verify that the audio files are displayed (Figure 6-5).

Figure 6-5 Scanned Audio Files

Step 8 (Optional) To create playlists of available media, see the “Creating a Playlist” topic in the Composer Pro 
User Guide.

Step 9 To scan Video files, in the Media list select Video Media, and then click Scan.

 • Video files must be in one of the following formats to be scanned: .avi, DVD, .iso, .m4a, mpeg, .mpg, 
or .wmv. These video files can only be played using a Control4 Media Player device or other video 
encoder that offers a compatible device driver.

 • Video is not supported from a USB drive, so the Video Media option is not displayed in the list under 
a USB drive.
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Define a Scanning Schedule
To automatically scan media devices for new or changed content, complete the following procedure. 
Scanning the media updates the content selections available in a touchscreen or on-screen Navigator, and 
uses an online service to update related information such as artwork and titles.

Procedure

Step 1 Click System Design. > Media (Figure 6-6).

Figure 6-6 Media Scanning Schedule

Step 2 Select Media Scanning Options.

Step 3 Select the Scanning Schedule options:

For example, you can scan the available media devices event x days, on specific days, and at a specific 
time.

Step 4 In the Files To Scan section, select the device(s) that will be automatically scanned, and add or remove 
the file types that will be scanned.

The list of supported files depends on the file types supported by the Cisco Controller.

Step 5 (Optional) Select the additional scanning options to use the online database, remove media that does not 
exist on the storage device, or update the media database if the file tags were changed. These options are 
selected by default.
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Related Documentation
See the “Media View” topic in the Composer Pro Getting Started Guide (Help > Contents) for a 
summary of the available Media options.

See the following topics in the Composer Pro User Guide for instructions to add additional audio video 
components, access media from additional storage devices, and use other sources for audio and video 
content (such as a television or radio station).

Configuring audio video features for use with the available media

 • Testing the Media Connection

 • Using External Storage Devices

 • Access and Scan Network Storage Devices

 • Creating a Playlist

 • Program a Button to Play Media or a Playlist

 • Configure Video Scanning of Network File Storage Devices

 • Configure a Media Player

 • Configure an Audio Matrix Switch

 • Configure an Audio or AV Switch

 • Configure a Dock for iPod

 • Configure a 4-Zone Amplifier

 • Configure a Multi Tuner

 • Configure a Speaker Point

Using additional media sources:

 • Setting Up Media for Television Channels

 • Setting Up Media for Radio Stations

 • Setting Up the Media

 • Setting Up Internet Radio Stations
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Adding a Network Camera
Complete the following procedure to add a Internet Protocol (IP) security camera to display video using 
the Cisco Smart+Connected Residential Solution. 

The on-screen and touchscreen Navigators provide access to the features supported by the camera, such 
as Pan, Tilt, Zoom (PTZ) controls, preset settings.

Tip For web JPEG Image only, use the “Web Image” driver and enter the URL and authentication 
user name and password (if a secure HTTP address), select the refresh rate in minutes, and test.

Prerequisites

 • Complete the “Create the Basic Project Configuration” section on page 5-8.

 • Ensure that the IP Security Camera is installed as specified in the manufacturer's installation guide.

Procedure

Step 1 Add the IP camera driver (Figure 6-7):

a. Select System Design.

b. Highlight the room or location where the camera is installed.

c. Select My Drivers and expand the IP cameras heading.

d. Double-click the appropriate device driver to add it to the project tree (Figure 6-7). 

For example, Panasonic Fixed Field Camera.

Figure 6-7 Adding a Network Camera

Step 2 In the Properties pane, enter the connection information that was configured on the device.
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See the product documentation for instructions to configure the network and authentication settings on 
the device. 

a. Enter the IP address and port number for the device.

b. Enter the authentication information (if applicable), such as the username and password required to 
access the device on the network. 

Step 3 Click Test HTTP Connection to test it.

Adding a Wireless Thermostat
Use the Composer Pro System Design and Connections views to set up a Wireless Thermostat.

Prerequisites

 • Complete the “Create the Basic Project Configuration” section on page 5-8.

 • Install the Thermostat at the wall according to the product documentation (for example, see the 
Control4 Wireless Thermostat Installation Guide).

Procedure

Step 1 Add the wireless thermostat driver (Figure 6-8):

a. Select System Design.

b. Highlight the room or location where the device is installed.

c. Select My Drivers and expand the HVAC heading.

d. Double-click the appropriate device driver to add it to the project tree (Figure 6-8). 

For example, Residential Thermostat.
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Figure 6-8 Adding a Wireless Thermostat

Step 2 Identify the device in the Composer Pro project as described in the “Create the Basic Project 
Configuration” section on page 5-8.

Step 3 Configure the thermostat using the following additional topics in the Composer Pro User Guide:

 • To program the schedule, see “Programming the Control4 Thermostat Schedule”. 

 • To set up advanced properties, see “Using the Wireless Thermostat Advanced Properties”.

 • For additional information, see “Configuring HVAC Systems”.

Where To Go Next
 • Saving the Project as a Template, page 5-31

 • Configuring the Intercom for Communication Within a Dwelling, page 7-1
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Configuring the Intercom for Communication 
Within a Dwelling

If your deployment supports the intercom feature for communication between the touchscreens in a 
dwelling, complete the following instructions.

Contents

 • Configuring the Intercom Agent for Use With Cisco Touchscreens, page 7-2

 • Understanding Agents, page 7-7

 • Programming Basics, page 7-9
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Configuring the Intercom Agent for Use With Cisco 
Touchscreens

The Intercom agent lets you configure the Cisco Touchscreens and Cisco External Video Door Stationfor 
audio and video intercom communication, including the ability to send broadcasts, monitor a room, and 
other controls. For example: if you have an elderly parent living in the residence, you can create a macro 
and assign it to a keypad button. If your family member needs help, they simply press the keypad button 
to notify you. Another example is a “Good Night” setting where all touchscreens in the house can be set 
to “Do Not Disturb” when it’s time to go to sleep. Or you can monitor your kids’ room after they’ve gone 
to bed to ensure that they’re going to sleep when they should.

For additional information, see the “Example: Program Using the Intercom Agent” in the Composer Pro 
User Guide. This example describes how to send a “test” announcement to a Cisco Touchscreen in the 
Master Bedroom that says “You are being monitored.” The Master Bedroom is then monitored.

Tip Many of the steps below (such as creating or removing groups and adjusting settings) can be performed 
on the supported touchscreens. 

Prerequisites

The following are added and identified (with a network address) in the project:

 • Cisco Controller configured with the device drivers and rooms for your deployment

 • Two or more compatible Cisco touchscreens or Cisco External Video Door Station.

 – Cisco In-wall Display

 – Cisco Portable Tablet 

 – Cisco External Video Door Station

 • Intercom agent (see below)

 • Macro agent

Limitations

Call groups for intercom broadcasts should not exceed 10 devices in any one call group. Call groups with 
more than 10 devices may experience inconsistent behavior with intercom broadcast calls.

Security Best Practices
The Cisco Video Door Stations are designed to be installed on the outside of a residence. These devices 
include connections for relays (to open doors, gates, etc.) and contacts. If installed without the proper 
security precautions, unauthorized access to the Cisco Video Door Stations could provide access to 
Ethernet signals, signaling, and gate or door relays. Sysco Systems advises partners and installers to be 
aware of these risks and take all necessary precautions depending on each specific installation you will 
be doing. 

It is each installer’s sole responsibility to advise the resident at each installation of any security risks 
specific to such installation. 
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Summary

Installers should take time to assure they are not creating an unforeseen security risk for the resident, 
and any such risks should be discussed with the resident prior to the installation. 

Carefully consider with your resident any contacts or relays before connecting them to the Video Door 
Station, and what implications could arise if someone gained access to the rear of the Video Door 
Station. 

Also, think about what could happen if someone gained access to the Ethernet cable, and take necessary 
precautions to protect private resident information unless your customer is willing to assume these risks. 
Making available the proper security protections to a resident for their residence is the responsibility of 
the Control4 Installer. 

Best Practices 

1. The Cisco External Video Door Station ships standard with security screws. Installers are 
encouraged to use these screws, or substitute alternate security screws. Screw size is metric 
M3.5x.6- 30L. 

2. Security gates or automatic doors should not be connected to the relay in the Cisco Video Door 
Station if mounted in an unsecured area; such relays could be accessed in the event of a breach of 
the device. Secure relay-driven devices should be connected to a more secure relay controller 
mounted behind a secure wall. 

3. Security devices, for example numeric keypads, should not be connected to the contact sensors in 
the Video Door Station if mounted in an unsecured area; such devices could be accessed in the event 
of a breach of the device. Security-sensitive devices should be connected to more secure contacts 
mounted behind a secure wall. 

4. Although the best video performance will be enabled by Ethernet connectivity, unauthorized access 
to the Video Door Station could provide access to the dwelling’s Ethernet network and 
corresponding personal data. 

Risk Mitigation

There are alternatives to mitigate this risk. The installer should consider the following options: 

 • Running the Cisco Smart+Connected Residential Solution on an isolated LAN from PCs on the 
network would limit exposure to personal data. 

 • Running MAC address filtering on the router or switch to force a hacker to spoof the Cisco Video 
Door Station’s MAC address to gain access to the LAN. 

 • Configuring the Video Door Station as WiFi instead of Ethernet would allow the Dealer to use robust 
WiFi security protocols, for example, WPA. 

Note WiFi signals must be very strong and stable to support video intercom. 

 • Routing the Ethernet cable to the Video Door Station through a secure managed switch to limit data 
access from the Video Door Station. 
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Procedure

Step 1 Select System Design > Agents (Figure 7-1). 

Step 2 (First time only) Click Add to add Intercom to the agent types list in the project. Select Intercom, and 
then click OK. The next time you want to configure the Intercom options, just select the Intercom item 
in the Agents pane.

Figure 7-1 Intercom Agent

Note All of the devices that support intercom functionality are displayed. In Figure 7-1 this includes 
the Cisco In-wall Display (In-Wall 7” touchscreen) and Cisco Portable Tablet (Portable 7” 
touchscreen).

Step 3 Select the Intercom agent (Figure 7-1). 

Step 4 Add an Intercom group.

An Intercom group is a set of Intercom-supported touchscreens that can be identified by a specific group 
name. This saves time when you want to send a broadcast to a group of people. Example: You can create 
a group (John’s Group) and then send a broadcast to that group.

a. In the Intercom Groups pane, click New. 

b. Name the Intercom group, and click Add. Example: “John's Group”.

c. Double click an “Available Device” to move it to the “Devices in Group” list.
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Figure 7-2 Intercom Agent

Step 5 Select the Manual Answer Popup Timeout (seconds).

Use the up or down arrow keys or type how much time is allowed to answer an incoming call.

Step 6 Adjust the settings for each touchscreen (in the Intercom Device Properties pane):

Table 7-1 Intercom Settings 

Intercom Setting Description

Exclude from 
Navigator

Select if you do not want these options enabled on the touchscreen. This option is 
useful when you want to broadcast messages to the touchscreens.

Do Not Disturb Select to enable. 

When a broadcast or call tries to connect to another touchscreen (for example, 
John’s Room), the message or call is blocked, and the caller’s touchscreen displays 
a “Do Not Disturb” or “Station Busy” message from the “John’s Room” 
touchscreen. On the caller’s touchscreen, tap Close to close the message.

Auto Answer Select to enable. 

When a call comes in from another touchscreen, that touchscreen rings and the 
caller's voice is heard (and video if activated). John, for example, (or whoever is 
in John's Room) can then speak to the caller from his or her touchscreen.
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Note • Broadcasting does not work in a room that’s being monitored if that room is in Monitor Mode. When 
in Monitor Mode, you will not want the person in that room to be disturbed, for example, a sleeping 
child.

 • Before you use broadcasting, make sure your Wi-Fi router is set to allow multicasting. Some routers 
do not allow multicasting. Check with your Dealer for details.

Step 7 Click Apply Changes when you're finished.

Send Video  Select to enable. 

When a call comes in from another touchscreen, the touchscreen rings and the 
caller's voice and video appear (if activated) on the caller's touchscreen. John, for 
example, (or whoever is in John's Room) can speak into his or her touchscreen and 
the caller can see them on the screen. 

Monitor Mode Select to enable. 

This monitors a room through the touchscreen in that room. This option sends 
audio and/or video to the touchscreen that is monitoring another room, for 
example, John’s Room. 

Table 7-1 Intercom Settings (continued)

Intercom Setting Description
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Understanding Agents
Composer Pro Agents are used in programming. Agents provide the ability to perform complex 
programming by using functional modules. There are various types of agents; for example, 
Announcements, Email Notifications, Scheduler, Lighting Scenes, Wakeup, etc.

Summary Steps

When you program with agents, you typically use these general steps:

1. In Agents, define an instance of a type of agent. 

2. In Programming, use the instance of the agent to program event actions. 

Example: 

 • In the Agent view, create a Custom Button that identifies all the buttons you want to program. 

 • In Programming, program the Custom Buttons.

For examples of using the intercom agent, see the “Configuring the Intercom Agent for Use With Cisco 
Touchscreens” section on page 7-2

Agent Types

Note Agents vary greatly in functionality and flexibility.

Table 7-2 Agent Types 

Agent Type Description
Related Topic in the 
Composer Pro User Guide

4Store Lets you set up and manage 4Store logins, apps, themes, and storage. “Example: Using the 
4Store Agent”

Announcements Plays a pre-recorded .WAV file, or displays a text message whenever a given 
event occurs. You can play an audio announcement on any audio output device 
with a supporting text message that displays on selected Navigators. 

Example: A Doorbell announcement plays a .WAV file that sounds like 
chimes and displays the following text on a touchscreen: “Someone is at the 
door” each time a doorbell is pressed. 

“Example: Program Using 
the Announcement Agent”

Custom Buttons Lets you make user interface buttons for specialized devices on the 
Navigators. 

“Example: Program Using 
the Custom Buttons Agent”

E-mail 
Notification

Lets you send an e-mail message to your email address when specified events 
occur as defined in programming. 

 • Remote Access is required to use the E-mail Notification Agent. See the 
Composer Pro Getting Started Help for details about Remote Access. 

 • Avoid setting up e-mail notifications for events that occur frequently 
(e.g., when a Motion Sensor detects motion). If the email notification 
trigger event occurs too often, it will cause the system to become 
sluggish.

“Example: Program Using 
the E-Mail Notification 
Agent” 
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Intercom Sets up the Intercom audio function for Cisco touchscreens. It also lets you 
set up SIP for multi-dwelling units (MDUs). 

“Example: Program Using 
the Intercom Agent”

See also the “Configuring 
the Intercom Agent for Use 
With Cisco Touchscreens” 
section on page 7-2.

Lighting Scenes Sets up a Lighting Scene. 

Example: By pressing one button on a Keypad, you can turn on assigned lights 
to specified ramp levels. 

“Example: Program Using 
the Lighting Scenes Agent”

Macros Macros agents associate programming with events. 

Example: You can create one macro to use in several different programming 
events or to use on a touchscreen when creating Favorites. 

“Example: Program Using 
the Macros Agent”

Media Scenes Creates a media scene that plays music in selected rooms on your system. “Example: Program Using 
the Media Scenes Agent”

Rhapsody Lets you activate or disable a Rhapsody account. “Example: Program Using 
the Rhapsody Agent”

Scheduler Defines conditionals of time to the system, and adds the ability to have 
scheduled events.

“Example: Program Using 
the Scheduler Agent”

Screen Saver Lets you set up a Screen Saver agent so you can create various Screen Savers. “Example: Program Using 
the Screen Saver Agent”

SNMP 
Configuration

Lets you set up and configure devices to monitor via SNMP. Requires 
knowledge of SNMP and network management. 

“Example: Program Using 
the SNMP Configuration 
Agent”

Timer Starts, stops, or repeats a timer based on a given event and action. 

Example: If a Motion Sensor in the system turns on a light when it detects 
motion, you can use a timer to turn off the light after 15 minutes. 
Alternatively, you can set a timer to repeat an action whenever the timer 
expires. 

“Example: Program Using 
the Timer Agent”

Variables Creates Boolean, string, and number variables. “Example: Review 
Programming with 
Variables”

Video Wall Creates a video wall for simultaneous viewing and control of multiple video 
sources on multiple displays. 

“Example: Program Using 
the Video Wall Agent” 

Wakeup Initiates a pre-specified wakeup time in the Navigators. This agent lets you 
play music, turn on lights, and change temperatures. 

“Example: Program Using 
the Wakeup Agent”

Table 7-2 Agent Types (continued)

Agent Type Description
Related Topic in the 
Composer Pro User Guide
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Programming Basics
Use Programming to program events and other actions that affect system devices.

Tip Use the Programming Detective in Tools > Detective Suite to keep track of your programming scripts. 
See the Composer Pro Getting Started guide for details.

Programming is based on events. When an event is triggered, other actions can take place. You drag and 
drop Events and Actions that you create for corresponding devices to a programming Script pane. 

Table 7-3 Programming Events, Actions and Scripts 

Programming Item Description

Events Events All programming begins with events. An event is a “when” statement. An event is the trigger 
report that something happened that results in an automation. Events happen instantaneously. On a 
Keypad, pushing a button is one event. Actions all occur under Events. Examples of events include:

 • When the door opens

 • When it is 7:00 AM

 • When it is sunrise

Actions After the event identifies to the system that something occurred, it sends actions. The following are the 
methods that are used by the system to define actions:

 • Commands. The Commands tab displays all available commands for a selected item in the Action 
Device Tree. A command is a “do” statement. Commands are actions the Director tells the device 
to do. Examples of commands include:

 – Light: on, off

 – VCR device: play, stop, pause

 – CD Changer device: go to disk

 – Security device: arm, disarm

 – TV device: Power on/off, change channel

 • Conditionals. The Conditionals tab displays all available conditionals for a selected item in the 
Action Device tree. A conditional is an “if” statement. An “if” statement asks a true/false question 
to the device. Examples of conditionals include:

 – If door is open

 – If after 5 PM

 – If light is greater than 50 percent

 • Loops. The Loops tab displays all available loops for a selected item in the Action Device tree. A 
loop is another type of conditional. A conditional loop is a “while” statement. It is something that 
is ongoing. Examples of conditional loops:

 – While the sprinklers are on

 – While the motion detector detects movement

 – While a doorbell switch is being pressed

 • Delays. A delay stalls a program from running to ensure actions that occur at the right time.
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Procedure

The following procedure includes simple events and actions in a sample programming configuration.

Step 1 Select Programming.

Step 2 Select a an event (left side of the window).

For example, when the bathroom fan starts. 

Step 3 Select an action that is triggered when the event occurs (right side of the window).

For example, start the “Bathroom Fan” timer.

Script The linking of events and actions is defined in the script.

Table 7-3 Programming Events, Actions and Scripts (continued)

Programming Item Description
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Step 4 Drag the Events and Actions commands to the Script pane (middle pane).
7-11
Cisco Smart+Connected Residential Installation and Configuration Guide

OL-26433-02



 

Chapter 7      Configuring the Intercom for Communication Within a Dwelling
  Programming Basics
7-12
Cisco Smart+Connected Residential Installation and Configuration Guide

OL-26433-02


	Cisco Smart+Connected Residential Installation and Configuration Guide
	Contents
	Preface
	Overview
	Requirements
	Summary Steps
	Obtaining and Installing Licenses
	Related Documentation

	Create the Design and Estimate Plans
	Overview
	Design Drawing Types
	Design and Estimate Requirements
	Summary Steps
	Download and Install the Cisco Smart Shapes for Visio
	Create a Concept Drawing and BOM Report
	Create a Single Line Drawing

	Network Requirements and Best Practices
	Overview
	Network Requirements
	ZigBee Wireless Requirements
	Wireless Access Point Best Practices
	Network Security Best Practices

	Install and Connect the Physical Components
	Overview
	Summary Steps
	Installation Requirements

	Create the Basic Cisco Controller Project
	Overview
	Template Configuration Requirements
	Summary Steps
	Overview of the Composer Pro Configuration Tool
	Connecting to a Director
	Composer Pro Overview
	Install the Composer Pro Software

	Create the Basic Project Configuration
	Devices Added in This Example
	Before You Begin
	Create the Project and Add Devices

	Create the Virtual Connections for Control (Serial) and Audio/Video Devices
	Verifying and Configuring Lighting Switches and Dimmers
	Related Documentation

	Saving the Project as a Template
	Where To Go Next

	Adding Additional Devices to the Template
	Summary Steps
	Add Access for Mobile Devices and PCs
	Troubleshooting Tips for Mobile Device Connectivity

	Adding Media From External Storage Devices
	Requirements
	Attach and Scan External USB Storage Devices
	Access and Scan Network Storage Devices
	Define a Scanning Schedule
	Related Documentation

	Adding a Network Camera
	Adding a Wireless Thermostat
	Where To Go Next

	Configuring the Intercom for Communication Within a Dwelling
	Configuring the Intercom Agent for Use With Cisco Touchscreens
	Security Best Practices

	Understanding Agents
	Programming Basics


